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 Photo Editor & Video Editor

Test Your Knowledge  (Page 10)

	The first picture is dark and unclear, but the second picture is much brighter and clearer.

Topic Flashback  (Page 13)

	

	 →

	 	
		  Original			       Rotate			    Flip

Quick Quiz (Page 19)
	 1.	 b	 2.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 c	 2.	 a	 3.	 d	 4.	 a	 5.	 d

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

1.
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A
Q 	 Answer the following questions: 

	 1.	 Using the Photos app, we can apply cropping, flipping, rotating, and filters to our photos. 
	 2.	� Corners and parts of boundary of the image are thick. These thick parts in the boundary 

are known as crop handles. With the help of these crop handles, you can crop a portion 
of a photo.

	 3.	 Some of the common features of OpenShot Video Editor are as follows:
	 	   Supports cross platforms 
	 	   Supports many video, audio, and image formats 
	 	   Supports 2D animations 
	 	   Supports drag and drop with the file system 
	 4.	   Menu Bar: It contains File, Edit, Title, View, and Help menus. 
	 	  � Main Toolbar: It provides quick access to common functions such as new project, open 

project, save project, undo, redo, import files, and export video. 
	 	   Function Tabs: It allows to switch between Project Files, Transitions, and Effects. 
	 	  � Project Files: It shows all the media files, such as videos, images, and audio, that have 

been imported into the project. These files can be dragged to the timeline for editing. 
	 	  � Preview Window: It displays the video playback while the project is being edited. Users 

can navigate the video and view changes in real time. 

	 Scratch Your Brain.
	 1.	 i. e. 	 ii. d.		  iii. c. 		  iv. b. 		  v. a. 

	 2.	 Competency-based/Application-based questions:

	 	 a. Jill can use Crop option to do so.
	 	 b. Tasshi can use OpenShot transition effects to do so.

 Explore in the Lab  

Do it yourself.

	Advanced Features of Word 2019

Test Your Knowledge  (Page 26)

2.
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Interdisciplinary Learning  (Page 29)
Do it yourself.

Topic Flashback  (Page 29)

	 1.	 SPELLING      2.  GRAMMAR      3.  THESAURUS      4.  REPLACE

Experiential Learning  (Page 35)

Do it yourself.

Quick Quiz (Page 35)
	 1.	 b	 2.	 b

Assess Yourself
	 Choose the correct option.

	 1.	 a	 2.	 d	 3.	 c	 4.	 b

	 Fill in the blanks with the correct words. 
	 1.	 Formatting	 2.	 Portrait	 3.	 Length, Width 
	 4.	 Layout	 5.	 Line

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	 	 5.	

A
Q 	 Answer the following questions: 

	 1.	� To change the paragraph spacing, follow the given steps: 
	 	 Step 1: Place the cursor in the paragraph. 
	 	 Step 2: Click on Layout tab. 
	 	 Step 3: �Click on the arrows in the Before and After spin boxes to choose the required 

spacing. 
	 2.	 The main steps of mail merge are: 
	 	  � Create the main document: The main document has the body of the letter or invitation 

that has to be sent. It contains merge fields. They are the places where data is inserted 
from the data source. 

	 	  � Create the data source: The data source contains the details of all the people to whom 
the letters will be sent. It can have the name, address, telephone numbers, e-mail address, 
etc. These details are inserted in the main document. 
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	 	  � Merged document: It combines the main document and the data source document to 
give a final document. 

	 3.	� The word “formmat” will show a red wavy line below it because it is a spelling mistake. The 
correct word should be “format”.

	 4.	 To use Thesaurus tool, follow the given steps: 
	 	 Step 1: Select the word. 
	 	 Step 2: Click on Review tab. 
	 	 Step 3: Click on the Thesaurus tool. 
	 	 Step 4: Click on down arrow and select Insert or Copy. 
	 5.	 To change the orientation, Noor should follow the given steps: 
	 	 Step 1: Click on Layout tab. 
	 	 Step 2: Click on Orientation command. 
	 	 Step 3: Choose Portrait or Landscape. 

	 Scratch Your Brain.
	 1.	 a.	� Highlighted word will type in the “Find what” box. and “damage” word will type in the 

“Replace with” box.
	 	 b.	� When you click on the Replace button, Word will replace the highlighted word with the word 

“damage.”

	 2.	 Competency-based/Application-based questions:

	 	 a.	� To view the entire document in three columns, Chris should select the text then go 
to the Layout tab, click on Columns command, and then select option Three from the 
dropdown menu.

	 	 b.	� To edit the list of contacts in mail merge, select the Edit Recipient List option from the 
Start Mail Merge group.

 Explore in the Lab
Do it yourself.

 More on PowerPoint 2019

Test Your Knowledge  (Page 41)

	 1.	 T	 2.	 T	 3.	 F	 4.	 F

Topic Flashback  (Page 49)

	 1.	 a.	 AIFF Audio (.aiff)	 b.	 AU Audio (.au)
	 2.	 d.	 .mp3

3.
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Interdisciplinary Learning  (Page 49)

Do it yourself.

Art Integration Learning
 (Page 49)

Do it yourself.

Quick Quiz (Page 50)
	 1.	 b.	 2.	 b.

Assess Yourself
	 Choose the correct option.

	 1.	 c.	 2.	 b.	 3.	 d.	 4.	 b.

	 Fill in the blanks with the correct words. 
	 1.	 Slides 	 2.	 Delete 	 3.	 URL 	 4.	 Entrance 

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	 Transition determines how your presentation moves from one slide to the next. 
	 	 Animations are special visual effects that you add to text and different objects on a slide. 
	 2.	 The group is used for “Animation Settings”, which includes: 
	 	 •	 Sound and its durations. 
	 	 •	 Whether to apply to this slide only or apply to all slides. 
	 	 •	 Moving to the next slide On Mouse Click or automatically after a set number of seconds. 
	 3.	 A → Play Button			  B → Stop Button 			  C → Record Button 
	 	 This window is used for managing audio/video playback in PowerPoint.
	 4.	 To insert an online video file, follow the given steps: 
	 	 Step 1: Click on the Insert tab. 
	 	 Step 2: Click on Video command. 
	 	 Step 3: Click on Online Video option. 
	 	 Step 4: Paste the URL of the video. 
	 	 Step 5: Click on the Insert button. 
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	 Scratch Your Brain.
	 1.	 a.	 Exit
	 	 b.	 This category has effects that control the exit of an object from the slide. 

	 2.	 Competency-based/Application-based questions:

	 	 a.	 Video on My PC 
	 	 b.	 To print a presentation, follow the given steps: 
	 		  Step 1: Click on File tab. 
	 		  Step 2: Click on the Print option. 
	 		  Step 3: Choose the desired print option. 
	 		  Step 4: Choose a layout to print. 
	 		  Step 5: Click on Print button. 

 Explore in the Lab  

Do it yourself.

Periodic Assessment-1
(Based on chapters 1 to 3)

A.	 1.	 Spelling and Grammar	 2.	 Thesaurus			   3.	 Find Tool
	 4.	 Replace Tool			   5.	 Orientation			   6.	 Edit Recipient List
B.	 1.	 Rotate 	 2.	 Flip 	 3.	 OpenShot Video Editor	 4.	 Timeline

C.	 7.  Click on Play/Pause button to play or pause the video file. 

	 2. Click on Video command.

	 4. Select the folder from the Explorer.

	 5. Select the video file. 

	 6. Click on the Insert button. 

	 3. Click on Video on My PC option. 

	 1.  Click on the Insert tab.
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 Introduction to Excel 2019

Test Your Knowledge  (Page 56)

Do it yourself.

Topic Flashback  (Page 59)

	 1.	 c.	 2.	 d.	 3.	 e.	 4.	 a.	 5.	 b.

Art Integration Learning
 (Page 60)

Do it yourself.

Interdisciplinary Learning  (Page 62)

	 1.	 B8	 2.	 C	 3.	 11 rows	 4.	 B12

Quick Quiz (Page 63)
	 1.	 b.	 2.	 a.

Assess Yourself
	 Choose the correct option.

	 1.	 a.	 2.	 c.	 3.	 d.	 4.	 b.

	 Fill in the blanks with the correct words. 
	 1.	 Spreadsheet 	2.	 Cell	 3.	 Enter 	 4.	 File

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	 i.	 Excel has built-in formulas and functions to do calculations. 
	 	 ii.	 The data can be formatted in many ways to change the look of the spreadsheet.  
	 	 iii.	 It is very easy to search and replace figures in a spreadsheet with just one command. 
	 	 iv.	 You can easily format the data in charts and graphs with the click of a mouse. 

4.
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	 2.	 Rows:								      
	 	 Run horizontally across the worksheet		
	 	 Identified by numbers (1,2,3...)			
	 	 Columns:
	 	 Run vertically in the worksheet
	 	 Identified by letters (A, B, C...)
	 3.	 To create a new workbook, follow the given steps: 
	 	 Step 1: Click on File tab. 
	 	 Step 2: Click on New option. 
	 	 Step 3: Click on Blank workbook.

	 Scratch Your Brain.
	 1.	 A → Cancel button 
		  B → Enter button 
		  C → Active cell 

	 2.	 Competency-based/Application-based questions:

	 a.	 The total number of rows is 1,048,576. The total number of columns in Excel is 16,384.
	 b.	 Simran can rename the worksheet by following these steps:
	 	 Step 1: Right-click on the sheet tab.
	 	 Step 2: Select the rename option.
	 	 Step 3: Type the new name for the worksheet.
	 	 Step 4: Press Enter to confirm the change.

 Explore in the Lab  

Do it yourself.

 Editing Cell Contents in Excel 2019

Test Your Knowledge  (Page 67)

	 1.	 c.	 2.	 d.	 3.	 a.	 4.	 b.

Topic Flashback  (Page 70)

	 1.	 Ctrl + A	 2.	 Shift + Arrow keys	 3.	 Ctrl	 4.	 Ctrl + Shift + @

5.



IMPRINT 1

9SmartGPT (4.0)-V (Answer Key)

Interdisciplinary Learning  (Page 71)

Do it yourself.

Art Integration Learning
 (Page 73)

Do it yourself.

Quick Quiz (Page 74)
	 1.	 b.	 2.	 b.

Assess Yourself
	 Choose the correct option.

	 1.	 a.	 2.	 a. 	 3.	 b.	 4.	 c. 

	 Fill in the blanks with the correct words. 
	 1.	 Range	 2.	 Undo	 3.	 Series	 4.	 Home

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	To delete an entire row, follow the given steps: 

	 	 Step 1: Click on the row header of the row you want to delete. 

	 	 Step 2: Click on Home tab. 

	 	 Step 3: Click on Delete drop-down arrow. 

	 	 Step 4: Select the Delete Sheet Rows option. 

	 2.	To change the format of date, follow these steps: 

	 	 Step 1: Select the cell where you want to edit the date. 

	 	 Step 2: Click on Home tab. 

	 	 Step 3: Click on the Number format dialog box launcher. 

	 	 Step 4: Select Date option in the Category section. 

	 	 Step 5: Choose the format you want. 

	 	 Step 6: Click on OK button. 
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	 3.	Mohan can select the cell range C3:F10 using only the keyboard by following these steps:

	 	 Step 1: Move to cell C3 using the Arrow keys.

	 	 Step 2: Press and hold Shift.

	 	 Step 3: Use the Right Arrow key to extend the selection to F3.

	 	 Step 4: Use the Down Arrow key to extend the selection to F10.

	 	 Step 5: Release the Shift key once the desired range C3:F10 is selected.

	 4.	To move the data, follow the given steps: 

	 	 Step 1: Select the cells you want to move. 

	 	 Step 2: Click on the Home tab. 

	 	 Step 3: Click on Cut button. 

	 	 Step 4: Click on the cell where you want to move the selected range. 

	 	 Step 5: Click on Paste button to move data. 

	 Scratch Your Brain.
	 1.	 A → It deletes the selected cells. The cells on the right are shifted to the left. 
	 	 B → It deletes the selected cells. The cells below shift up. 
	 		 C → It deletes the selected row. The row below shifts up. 
	 	 D → It deletes the selected column. The columns on the right are shifted to the left. 

	 2.	 Competency-based/Application-based questions:

	 	 a.	 Clicking on the row number on the left side of the worksheet.
	 	 b.	 Sana can use the Autofill feature in Excel to quickly fill in the dates for March.

 Explore in the Lab  

Do it yourself.

Periodic Assessment-2
(Based on chapters 4 & 5)

A.	 1.	 It deletes the selected cells. The cells on the right are shifted to the left.
	 2.	 It deletes the selected cells. The cells below shift up.
	 3.	 It deletes the selected row. The row below shifts up.
	 4.	 It deletes the selected column. The columns on the right are shifted to the left.
	 5.	 The Cancel button is used to cancel the typing task.
	 6.	 This is Insert Function button.
	 7.	 The Enter button is used to insert the text.
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B.	 1.	 Enter key	 2.	 Excel	 3.	 Delete	
	 4.	 Undo	 5.	 Cell
C.	   Quick Access Toolbar

Ribbon

Scroll bar

Columns
Rows

Status bar

Name box

File tab

Active cell

Formula bar

Cell

Title bar

Sheet tab View bar

Test Sheet–1
(Based on chapters 1 to 5)

A.	 1.	 c.	 2.	 a.	 3.	 d.	 4.	 c.	 5.	 c. 
	 6.	 d.	 7.	 c.	 8.	 b.	 9.	 a.	 10.	 c.
B.	 1.	 Portrait 	 2.	 Layout 	 3.	 Entrance 	 4.	 Cell
C.	 1.	 	 2.	 	 3.	 	 4.	 	 5.	
D.	 1.	 Some of the common features of OpenShot Video Editor are as follows: 
	 	 •	� Supports cross platforms 
	 	 •	 Supports many video, audio, and image formats 
	 	 •	 Supports 2D animations 
	 	 •	 Supports drag and drop with the file system 
	 2.	� Corners and parts of boundary of the image are thick. These thick parts in the boundary 

are known as crop handles. With the help of these crop handles, you can crop a portion 
of a photo.

	 3.	 The main steps of mail merge are: 
	 	 •	� Create the main document: The main document has the body of the letter or invitation 

that has to be sent. It contains merge fields. They are the places where data is inserted 
from the data source. 

	 	 •	� Create the data source: The data source contains the details of all the people to whom 
the letters will be sent. It can have the name, address, telephone numbers, e-mail 
address, etc. These details are inserted in the main document. 

	 	 •	� Merged document: It combines the main document and the data source document to 
give a final document. 



SmartGPT (4.0)-V (Answer Key)12

IMPRINT 1

	 4.	 Transition determines how your presentation moves from one slide to the next. 
	 	 Animations are special visual effects that you add to text and different objects on a slide. 
	 5.	 Rows:
	 	 Run horizontally across the worksheet
	 	 Identified by numbers (1,2,3...)
	 	 Columns:
	 	 Run vertically in the worksheet
	 	 Identified by letters (A, B, C...)
	 6.	 To create a new workbook, follow the given steps: 
	 	 Step 1: Click on File tab. 
	 	 Step 2: Click on New option. 
	 	 Step 3: Click on Blank workbook. 
	 7.	 To delete an entire row, follow the given steps: 
	 	 Step 1: Click on the row header of the row you want to delete. 
	 	 Step 2: Click on Home tab. 
	 	 Step 3: Click on Delete drop-down arrow. 
	 	 Step 4: Select the Delete Sheet Rows option. 
	 8.	 To change the format of date, follow these steps: 
	 	 Step 1: Select the cell where you want to edit the date. 
	 	 Step 2: Click on Home tab. 
	 	 Step 3: Click on the Number format dialog box launcher. 
	 	 Step 4: Select Date option in the Category section. 
	 	 Step 5: Choose the format you want. 
	 	 Step 6: Click on OK button.

 Internet and E-mail 

Test Your Knowledge  (Page 82)

 	 Search information	 	 Take a bath 

 	 Find a recipie	  	 Download an image

	 Pack your bag	  	 Do shopping

6.
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Topic Flashback  (Page 84)

	 1.	 Mobile Internet 		 2.	 Internet 	 3.	 Dial-up 		  4.	 broadband 

Experiential Learning  (Page 89)

Do it yourself.

Quick Quiz (Page 89)
	 1.	 b.	 2.	 b.

Assess Yourself
	 Choose the correct option.

	 1.	 b.	 2.	 a.	 3.	 d.	 4.	 c.

	 Fill in the blanks with the correct words. 
	 1.	 Wi-Fi	 2.	 Compose	 3.	 Attachment	 4.	 Carbon Copy (CC)

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	 Dial-up requires users to link their phone line to a computer in order to access the Internet. 
	 	� Broadband is provided through either cable or telephone companies. It is a high-speed 

Internet connection. 
	 2.	 Steps to open a website in a web browser are:
	 	 Step 1: Open a web browser (e.g., Chrome, Firefox, Edge).
	 	 Step 2: Click on the address bar.
	 	 Step 3: Type the website URL (e.g., www.example.com).
	 	 Step 4: Press Enter to open the website.
	 3.	 E-mails have various advantages, some of them are: 
	 	 •	 An e-mail is a way to communicate virtually with anyone in the world. 
	 	 •	 An e-mail can be sent anytime and from anywhere in the world. 
	 	 •	 An e-mail can be sent to many people at a time. 
	 	 •	 An e-mail can be easily forwarded to anyone without typing it again. 
	 4.	� It is very important to sign out from your account so that no one else using that computer 

can read your e-mails or send unwanted e-mails from your e-mail account. 



SmartGPT (4.0)-V (Answer Key)14

IMPRINT 1

	 Scratch Your Brain.
	 1.	 Do it yourself.

	 2.	 Competency-based/Application-based questions:

	 	 a.	 To send an email to Armeet, you will write “armeet@gmail.com” in the “To” field.
	 	 b.	 In the “Subject” field, you can write: “Congratulations on Your New Home!”
	 		�  It is necessary to fill the Subject field because it helps the recipient understand the 

purpose of the email.

 Explore in the Lab  

Do it yourself.

 Safeguarding Your Computer

Test Your Knowledge  (Page 94)

Do it yourself.

Topic Flashback  (Page 97)

	 1.	 d.	 2.	 b.	 3.	 a.	 4.	 c.

Interdisciplinary Learning  (Page 97)

Do it yourself.

Experiential Learning  (Page 98)

Do it yourself.

Quick Quiz (Page 98)
	 1.	 b.	 2.	 b.

Assess Yourself
	 Choose the correct option.

	 1.	 d.	 2.	 a.	 3.	 b.	 4.	 c.

7.
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	 Fill in the blanks with the correct words. 
	 1.	 Adware 	 2.	 Storm 	 3.	 Emotet 	 4.	 Mydoom 

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	� A computer virus is a program that is able to copy itself when it is run. It gets activated 
each time the program or file to which it is attached is opened or executed. It is the most 
common type of malware. It can spread itself by infecting other programs or files. This 
affects the original program, causing it to no longer work properly. 

	 2.	 Different malwares will affect your computer in different ways. 
	 	 •	 They can crash your hard disk. 
	 	 •	 They can destroy all or some of your data. 
	 	 •	 They decrease the processing speed of the computer. 
	 	 •	 They can reduce or block the memory of the computer or hard disk. 
	 3.	� Jyoti should not download or open the attachment as it may contain malware. She should 

delete the email, verify the sender, and scan attachments with antivirus software to stay 
safe.

	 4.	 An infected computer system will: 
	 	 •	 start displaying unusual messages on the screen 
	 	 •	 take time to load the programs
	 	 •	 take more time to shut down the Windows 
	 	 •	 increase the size of the files 

	 Scratch Your Brain.
	 1.	 a.	 ILOVEYOU Virus 	 b.	 Code Red Worm 		 c.	 Zeus

	 2.	 Competency-based/Application-based questions:

	 	 a.	 Trojan Horse
	 	 b.	� To protect his new computer from malware, I would advise my friend to install antivirus 

software, avoid downloading files from unknown sources, keep the system updated, 
use strong passwords, and avoid clicking on suspicious links or emails.

 Explore in the Lab  

Do it yourself.
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Periodic Assessment-3
(Based on chapters 6 & 7)

A.	 1.	� Broadband is provided through either cable or telephone companies. It is a high-speed 
Internet connection. 

	 2.	 Dial-up requires users to link their phone line to a computer in order to access the Internet. 
	 3.	� Mobile Internet allows users to access the Internet over a smartphone provided with offers 

on voice plans with Internet access. 
	 4.	� An Electronic mail or e-mail can be defined as the process of exchanging messages 

electronically through a communication network by using computer. 
B.	 1.	 Code Red Worm	 2.	 Zeus	 3.	 Emotet	 4.	 Pegasus
C.	 1.	 (i)	 2.	 (iii)	 3.	 (ii)

 Data Processing

Test Your Knowledge  (Page 103)

Do it yourself.

Interdisciplinary Learning  (Page 104)

Do it yourself.

Topic Flashback  (Page 106)

4%#32

Quick Quiz (Page 106)
	 1.	 b.	 2.	 b.

Assess Yourself
	 Choose the correct option.

	 1.	 b.	 2.	 a.	 3.	 d.

A
Q 	 Answer the following questions: 

	 1.	� Data refers to the raw input. When this data is processed, the outcome received is known 
as information. 

8.
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	 2.	� Kristina chose to represent the data in tabular format because it makes the information 
clear, organised, and easy to understand.

	 3.	 Information can be represented in the following four ways:
	 	 i.	 Tables	 ii.	 Pictures	 iii.	 Maps	 iv.	 Pictograms  

	 Scratch Your Brain.
	 1.	 OVCFL

	 2.	 Competency-based/Application-based questions:

	 	 a.	� Ahsan keeps his books in alphabetical order because it makes them easy to find and 
organise. This method helps in quick access, saves time, and keeps the bookshelf neat 
and structured.

	 	 b.	 Coded data 

 Explore in the Lab  

Do it yourself.

 More on Scratch

Test Your Knowledge  (Page 109)

Do it yourself.

Experiential Learning  (Page 110)

Do it yourself.

Topic Flashback  (Page 112)

	 1.	 Ask block			   2.	 Logical Operator block
	 3.	 Arithmetic Operator block	 4.	 Relational Operator block

Quick Quiz (Page 117)
	 1.	 b.	 2.	 a.

9.
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Assess Yourself
	 Choose the correct option.

	 1.	 c.	 2.	 a.	 3.	 b.	 4.	 d.

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

	 Fill in the blanks with the correct words. 
	 1.	 Operators 	 2.	 Not 	 3.	 Two 	 4.	 If…then  

A
Q 	 Answer the following questions: 

	 1.	� This block checks if the chosen key is pressed by the user. If true, then it executes a set of 
blocks, else executes another set of blocks. 

	 2.	� All the numbers, text, date or pictures that we use in a program are called data. We store 
this data in the computer memory so that we can get information from it later. This data 
is stored in variables. It is called variable because it does not have a fixed value, its value 
changes. 

	 3.	� Saman should use an Arithmetic Operator to calculate the product of two numbers. The 
most appropriate operator block in Scratch is the Multiplication (*) block.

	 4.	 To create variables in Scratch, follow the given steps: 
	 	 Step 1: Click on Variables block category. 
	 	 Step 2: Click on Make a Variable block. 
	 	 Step 3: Type a variable name in the New variable name box. 
	 	 Step 4: Select “For this sprite only” to make the variable specific to the Cat Sprite. 
	 	 Step 5: Click on Ok button. 

	 Scratch Your Brain.
	 1.	 Do it yourself.

	 2.	 Competency-based/Application-based questions:

	 	 a.	 To run a set of blocks 5 times in Scratch, you should use the “Repeat (5)” block.
	 	 b.	 (iv) 

 Explore in the Lab
Do it yourself.

   Robotics

Test Your Knowledge  (Page 122)

1.  Cooking food	  	 2.  Doing homework	 

3.  Cleaning room	  	 4.  Hurt feeling	

Art Integration Learning
 (Page 124)

Do it yourself.

Topic Flashback  (Page 124)

	 1.	 d. 	 2.	 a. 	 3.	 b. 	 4.	 c. 

Experiential Learning  (Page 127)

Do it yourself.

Quick Quiz (Page 127)
	 1.	 b.	 2.	 b.

Assess Yourself
	 Choose the correct option.

	 1.	 b.	 2.	 c.	 3.	 a.	 4.	 a.

	 Fill in the blanks with the correct words. 
	 1.	 Unimate 	 2.	 Robonaut 2	 3.	 Underwater	 4.	 Sophia	 5.	 Zenbo 

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	� In entertainment industries, robots are proving to be a great help in managing the cameras, 
providing special effects, performing stunts in an action movie, etc. 

10.
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   Robotics

Test Your Knowledge  (Page 122)

1.  Cooking food	  	 2.  Doing homework	 

3.  Cleaning room	  	 4.  Hurt feeling	

Art Integration Learning
 (Page 124)

Do it yourself.

Topic Flashback  (Page 124)

	 1.	 d. 	 2.	 a. 	 3.	 b. 	 4.	 c. 

Experiential Learning  (Page 127)

Do it yourself.

Quick Quiz (Page 127)
	 1.	 b.	 2.	 b.

Assess Yourself
	 Choose the correct option.

	 1.	 b.	 2.	 c.	 3.	 a.	 4.	 a.

	 Fill in the blanks with the correct words. 
	 1.	 Unimate 	 2.	 Robonaut 2	 3.	 Underwater	 4.	 Sophia	 5.	 Zenbo 

	� Tick ( ) the correct statements and cross ( ) the wrong ones.
	 1.	 	 2.	 	 3.	 	 4.	

A
Q 	 Answer the following questions: 

	 1.	� In entertainment industries, robots are proving to be a great help in managing the cameras, 
providing special effects, performing stunts in an action movie, etc. 

10.



SmartGPT (4.0)-V (Answer Key)20

IMPRINT 1

	 2.	 The robot that helped Hiroshi at the Tokyo-Mitsubishi UFJ Bank is Nao.
	 	 It speaks and understands Japanese, English and Chinese.
	 3.	� If you are not a fan of cooking Moley Robotic Kitchen is the right robot to own. This robot 

is claimed to have skills of master chef. It would learn new recipes, cook for you, and clean 
up afterwards. 

	 4.	� Surgical robots help doctors in performing surgery in healthcare field. Some of the 
humanoids can be a good companion to the recovering patients with serious illness. 

	 Scratch Your Brain.
	 1.	 a.	 Nadine 	 b.	 Sophia 	 c.	 Paro 	 d.	 Root 

	 2.	 Competency-based/Application-based questions:

	 	 a.	 Suzumo Sushi Chef 	 b.	 Z-Machines 

 Explore in the Lab
Do it yourself.

Periodic Assessment-4
(Based on chapters 8 to 10)

A.	 1.	 Logical Operators	 2.	 Arithmetic Operators	 3.	 Sensing Blocks
B.	 1.	 T-HR3	 2.	 Sophia	 3.	 RoboThespain	
	 4.	 Nao	 5.	 Paro	 6.	 Z-Machines
C.	 1.	 A Script can be made by Sensing blocks.
	 2.	 Sophia is the first humanoid to receive citizenship of a country.
	 3.	� RoboThespain is an actor that comes with a library of impressions, greetings, songs and 

gestures.
	 4.	 Data refers to the raw input.
	 5.	 Zenbo is a low-cost robot capable of rolling around freely.
	 6.	 Arranging data in a specific order is known as Sorting.

Test Sheet–2
(Based on chapters 6 to 10)

A.	 1.	 b.	 2.	 a. 	 3.	 d.	 4.	 b.	 5.	 a.
	 6.	 d.	 7.	 c.	 8.	 b.	 9.	 b.	 10.	 c.
B.	 1.	 Compose	 2.	 Adware 	 3.	 Not 	 4.	 Two 	 5.	 Sophia 
C.	 1.	 	 2.	 	 3.	 	 4.	 	 4.	
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D.	 1.	 Dial-up requires users to link their phone line to a computer in order to access the Internet. 
	 	� Broadband is provided through either cable or telephone companies. It is a high-speed 

Internet connection. 
	 2.	 E-mails have various advantages, some of them are: 
	 	 •	 An e-mail is a way to communicate virtually with anyone in the world. 
	 	 •	 An e-mail can be sent anytime and from anywhere in the world. 
	 	 •	 An e-mail can be sent to many people at a time. 
	 	 •	 An e-mail can be easily forwarded to anyone without typing it again. 
	 3.	 Different malwares will affect your computer in different ways. 
	 	 •	 They can crash your hard disk. 
	 	 •	 They can destroy all or some of your data. 
	 	 •	 They decrease the processing speed of the computer. 
	 	 •	 They can reduce or block the memory of the computer or hard disk. 
	 4.	 Data can be represented in the following four ways:
	 	 i.	 Tables	 ii.	 Pictures	 iii.	 Maps	 iv.	 Pictograms   
	 5.	� All the numbers, text, date or pictures that we use in a program are called data. We store 

this data in the computer memory so that we can get information from it later. This data 
is stored in variables. It is called variable because it does not have a fixed value, its value 
changes.

	 6.	 To create variables in Scratch, follow the given steps: 
	 	 Step 1: Click on Variables block category. 
	 	 Step 2: Click on Make a Variable block. 
	 	 Step 3: Type a variable name in the New variable name box. 
	 	 Step 4: Select “For this sprite only” to make the variable specific to the Cat Sprite. 
	 	 Step 5: Click on Ok button. 
	 7.	� In entertainment industries, robots are proving to be a great help in managing the cameras, 

providing special effects, performing stunts in an action movie, etc. 


